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1
Computer Diagnostic Features

Diagnostics for Windows
The Diagnostics for Windows (DFW) utility allows you to view 
information about the hardware and software configuration of the 
computer while running Microsoft Windows XP. It also allows you to 
perform hardware and software tests on the subsystems of the 
computer.

When you invoke Diagnostics for Windows, the Overview screen is 
displayed, which shows the current configuration of the computer. 
From the Overview screen, there is access to several categories of 
information about the computer and the Test tab. The information in 
every screen of the utility can be saved to a file or printed.

✎ To test all subsystems, you must log in as the administrator. If you do 
not log in as the administrator, you will be unable to test some 
subsystems. The inability to test a subsystem will be indicated by an 
error message under the subsystem name in the Test window or by 
shaded check boxes that cannot be selected.

Use Diagnostics for Windows to determine if all the devices installed 
on the computer are recognized by the system and functioning 
properly. Running tests is optional but recommended after installing 
or connecting a new device.

Third party devices not supported by HP may not be detected by 
Diagnostics for Windows. Save, print, or display the information 
generated by the utility. You should run tests and have the printed 
report available before placing a call to the Customer Support Center.
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Detecting Diagnostics for Windows
Some computers ship with the Diagnostics for Windows preloaded, 
but not preinstalled. You may have installed it earlier, along with 
other utilities, or it may have been installed by another user.

To determine whether Diagnostics for Windows is installed:

1. Access the location of the Diagnostics icons. In Windows XP 
Home or Windows XP Professional, select Start > Control 
Panel.

2. Look through the displayed icons in the Control Panel.

❏ If icons for Configuration Record and Diagnostics for 
Windows are included, the Diagnostics for Windows utility is 
installed.

❏ If icons for Configuration Record and Diagnostics for 
Windows are not included, the Diagnostics for Windows 
utility may be loaded, but not installed.
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Installing Diagnostics for Windows
If Diagnostics for Windows is not preloaded, you can download the 
Diagnostics for Windows SoftPaq from the following Web site:

www.hp.com/support

The following operation is required only if the diagnostics program 
software has been loaded on the hard drive but not installed.

1. Close any Windows applications.

2. Install the Diagnostics for Windows utility:

❏ In Windows XP, select Start > Software Setup icon. Select 
Diagnostics for Windows > Next button, then follow the 
instructions on the screen.

❏ If the Setup Software icon is not on the Desktop or in the 
Start menu, run the Setup program from the 
C:\CPQAPPS\DIAGS directory or select Start > Run and 
type the following in the command line: 
C:\CPQAPPS\DIAGS\SETUP.

3. Click Next to install Diagnostics for Windows.

4. After the program has finished installing, you may be prompted 
to restart the computer, or it may automatically restart. If 
prompted, click Finish to restart the computer or Cancel to exit 
the program. You must restart the computer to complete the 
installation of Diagnostics for Windows.

✎ If you want to upgrade an existing version of Diagnostics 
for Windows installed on the computer, visit www.hp.com/support to 
locate and download the latest Diagnostics for Windows SoftPaq.
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Computer Diagnostic Features
Using Categories in Diagnostics for Windows
To use the categories do the following:

1. Click Start > HP Information Center > Diagnostics for 
Windows. You can also select the Diagnostics for Windows 
icon, located in the Control Panel, by clicking Start > Control 
Panel, then select Diagnostics for Windows.

The screen displays the overview of the computer hardware and 
software.

2. For specific hardware and software information, select a category 
from the Categories pull-down menu or the appropriate icon on 
the toolbar.

✎ As you move the cursor over the toolbar icons, the corresponding 
category name displays near the cursor.

3. To display more detailed information in a selected category, click 
More in the Information Level box in the lower left corner of the 
window or click Level at the top of the screen and select More.

4. Review, print, and/or save this information as needed.

✎ To print the information, click File, then select Print. Select one of 
the following options: Detailed Report (All Categories), Summary 
Report (All Categories), or Current Category. Click OK to print 
the report you selected.

✎ To save the information, click File, then select Save As. Select one of 
the following options: Detailed Report (All Categories), Summary 
Report (All Categories), or Current Category. Click OK to save 
the report you selected.

5. To exit Diagnostics for Windows, click File, and then click Exit.
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Menu Bar—File, Categories, Navigation, Level, Tab, Help
At the top of the Diagnostics for Windows screen is the Menu Bar 
consisting of six pull-down menus:

■ File—Save As, Print, Printer Setup, Exit

■ Categories—See the list of categories in the following section

■ Navigation—Previous Category (F5), Next Category (F6)

■ Level—Less (F7), More (F8) <information on the screen>

■ Tab—Overview, Test, Status, Log, Error

■ Help—Contents, How to use Help, About

Tool Bar—Icons for Different Categories of Information
Below the Menu Bar, the Tool Bar contains a row of icons for each of 
the following categories of information about the computer:

■ System—System board, ROM, date, and time information

■ Asset Control—Asset tag, system serial number, and processor 
information

■ Input Devices—Keyboard, mouse, and joystick(s) information

■ Communication—Ports in system and information about each

■ Storage—Storage drives in system and information about each

■ Graphics—Graphics system information

■ Memory—System board and Windows memory information

■ Multimedia—Optical storage (CD, DVD, and so on) and audio 
information

■ Windows—Windows information

■ Architecture—PCI Device information

■ Resources—IRQ, I/O, and Memory Map information

■ Health—Status of system temperature and hard drives

■ Miscellaneous—CMOS, DMI, BIOS, System, Product Name, 
and Serial Number
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Tabs—Overview, Test, Status, Log, Error
Below the Tool Bar are five tabs:

■ Overview—The Overview window displays general overview 
information about the computer. This is the window that is 
displayed when you first start the utility. The left side of the 
window shows hardware information, and the right side of the 
window shows software information.

■ Test—The Test window allows you to choose various parts of 
the system to test. You can also choose the type of test and 
testing mode.

■ Status—The Status window displays the status of each test in 
progress. You can cancel testing by clicking the Cancel Testing 
button.

■ Log—The Log window displays a log of tests for each device.

■ Error—The Error window displays any errors that occurred 
during device testing. The window lists the device being tested, 
the type and number of errors, and the error code.

Running Diagnostic Tests in Diagnostics for Windows
To run diagnostic tests:

1. Click Start > HP Information Center > Diagnostics for 
Windows. You can also select the Diagnostics for Windows 
icon, located in the Control Panel, by clicking Start > Control 
Panel, then select Diagnostics for Windows.

The screen displays the overview of the computer hardware and 
software. Five tabs are displayed below the row of icons: 
Overview, Test, Status, Log, and Error.

2. Click the Test tab, or click Tab at the top of the screen and 
select Test.

3. Select one of the following options:

❏ Quick Test—Runs a quick, general test on each device. 
Requires no user intervention if Unattended Mode is selected.

❏ Complete Test—Runs maximum testing of each device. The 
user can select Interactive Mode or Unattended Mode.
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❏ Custom Test—Runs only the tests you select. To select 
specific devices or tests, find the device in the list, then select 
the check box beside each test. When selected, a red check 
mark is displayed in the box. Some tests selected may require 
user intervention.

✎ To test all subsystems, you must log in as the administrator. If you do 
not log in as the administrator, you will be unable to test some 
subsystems. The inability to test a subsystem will be indicated by an 
error message under the subsystem name in the Test window or by 
shaded boxes that cannot be checked.

4. Select Interactive Mode or Unattended Mode. In Interactive 
Mode, the diagnostic software will prompt you for input during 
tests that require it. Some tests require interaction and will 
display errors or halt testing if selected in conjunction with 
Unattended Mode.

❏ Interactive Mode provides maximum control over the testing 
process. You determine whether the test passed or failed and 
may be prompted to insert or remove devices.

❏ Unattended Mode does not display prompts. If errors are 
found, they are displayed when testing is complete.

5. Click the Begin Testing button at the bottom of the window. Test 
Status is displayed, showing the progress and result of each test. 
For more details on the tests run, click the Log tab or click Tab at 
the top of the screen and select Log.

6. To view a test report, select a tab:

❏ The Status tab summarizes the tests run, passed, and failed 
during the current testing session.
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❏ The Log tab lists tests run on the system, the numbers of 
times each test has run, the number of errors found on each 
test, and the total run time of each test.

❏ The Error tab lists all errors found on the computer with 
their error codes.

7. To save a test report:

❏ Select the Log tab Save button to save a Log tab report.

❏ Select the Error tab Save button to save an Error tab report.

8. To print a test report:

❏ If the report is on the Log tab, select File > Save As, then 
print the file from the selected folder.

❏ If the report is on the Error tab, select the Error tab Print 
button.

9. If errors are found, click the Error tab to display more detailed 
information and recommended actions. By following the 
recommended actions, you may be able to solve some problems 
yourself.

10. Click Print or save the error information in case you need to 
contact an authorized dealer, reseller, or service provider for 
assistance.

11. To exit Diagnostics for Windows, click File, then click Exit.
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Configuration Record
The Configuration Record utility is a windows-based 
information-gathering tool similar to other management tools. It 
gathers critical hardware and software information from various 
computer subsystems to give a complete view of the computer. 
Configuration Record provides a means for automatically identifying 
and comparing configuration changes, and has the ability to maintain 
a configuration history. The information can be saved as a history of 
multiple sessions.

This utility was developed to allow resolution of problems without 
taking the computer offline and to assist in maximizing the computer 
availability. The information obtained by the utility is useful in 
troubleshooting system problems, and streamlines the service process 
by enabling quick and easy identification of system configurations, 
which is the first step in resolving service cases.

The Configuration Record gathers information automatically on the 
hardware and operating system software to deliver a comprehensive 
view of the system. It gathers information on such items as the ROM, 
asset tag, processor, physical drives, PCI devices, memory, graphics, 
operating system version number, operating system parameters, and 
the operating system startup files and displays it. If the original 
Base.log file is present in the cpqdiags directory, the Base.log file is 
displayed next to the Now.log file in a split window with the 
differences between the two highlighted in the color red.
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Installing Configuration Record
The Configuration Record is part of Diagnostics for Windows. 
Whenever you install Diagnostics for Windows, the Configuration 
Record is also installed.

Running Configuration Record
To run this program:

1. Click Start > HP Information Center > Configuration Record. 
You can also select the Configuration Record icon, located in 
the Control Panel, by clicking Start > Control Panel, then select 
Configuration Record.

✎ The Configuration Record utility has two view options: Show 
Changed Items Only and Show All. The default view is 
Show Changed Items Only, therefore all the text is displayed in the 
color red since it shows only the differences. Switching to Show All 
displays the complete, comprehensive view of the system.

2. The default view is Show Changed Items Only. To view all the 
information gathered by Configuration Record, click View at the 
top of the window and select Show All, or click the Show All 
Items icon.

3. To save the information in the left or right window, select File > 
Save Window File and then select Left Window File or Right 
Window File.

✎ Saving the configuration of the computer periodically allows the user 
to keep a history of the configuration. This history may be useful to 
your service provider if the system ever encounters a problem that 
needs debugging.

4. To exit Configuration Record, click File, then click Exit.
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Protecting the Software
To protect software from loss or damage, you should keep a backup 
copy of all system software, applications, and related files stored on 
the hard drive. See the operating system or backup utility 
documentation for instructions on making backup copies of data files.

Restoring the Software
The Windows operating system and software can be restored to the 
original state that they were when you purchased the computer by 
using the Restore Plus! CD. See the documentation included with the 
Restore Plus! CD for complete instructions on using this feature.
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Troubleshooting Without Diagnostics

This chapter provides information on how to identify and correct 
minor problems, such as diskette drive, hard drive, optical drive, 
graphics, audio, memory, and software problems. If you encounter 
problems with the computer, refer to the tables in this chapter for 
probable causes and recommended solutions. 

✎ For information on specific error messages that may appear on the 
screen during Power-On Self-Test (POST) at startup, refer to 
Appendix A, “POST Error Messages.”

Safety and Comfort

Å
WARNING: Misuse of the computer or failure to establish a safe  
and comfortable work environment may result in discomfort or  
serious injury. Refer to the Safety & Comfort Guide on the  
Documentation CD and available on the Web site at www.hp.com/ergo, 
for more information on choosing a workspace and creating a safe and 
comfortable work environment. 
 
This equipment has been tested and found to comply with the limits for a 
Class B digital device, pursuant to Part 15 of the FCC Rules. For more 
information, refer to Safety & Regulatory Information on the 
Documentation CD.
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Before You Call for Technical Support
If you are having problems with the computer, try the appropriate 
solutions below to try to isolate the exact problem before calling for 
technical support.

■ Run the Diagnostics for Windows utility. Refer to Chapter 1, 
“Computer Diagnostic Features” for more information.

■ Run the Drive Protection System (DPS) Self-Test in Computer 
Setup. Refer to the Computer Setup (F10) Utility Guide on the 
Documentation CD for more information.

■ Check the Power LED on the front of the computer to see if it is 
flashing red. The flashing lights are error codes that will help you 
diagnose the problem. Refer to Appendix A, “POST Error 
Messages” for more information.

■ If the screen is blank, plug the monitor into a different video port 
on the computer if one is available. Or, change out the monitor 
with a monitor that you know is functioning properly.

■ If you are working on a network, plug another computer with a 
different cable into the network connection. There may be a 
problem with the network plug or cable.

■ If you recently added new hardware, remove the hardware and 
see if the computer functions properly.

■ If you recently installed new software, uninstall the software and 
see if the computer functions properly.

■ Boot the computer to the Safe Mode to see if it will boot without 
all of the drivers loaded. When booting the operating system, use 
“Last Known Configuration.”

■ Refer to the comprehensive online technical support at 
www.hp.com/support.

■ Refer to the following “Helpful Hints” section in this guide.

■ Run the Restore Plus! CD.

Ä
CAUTION: Running the Restore Plus! CD will erase all data on the hard 
drive.
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To assist you in resolving problems online, HP Instant Support 
Professional Edition provides you with self-solve diagnostics. If you 
need to contact HP support, use HP Instant Support Professional 
Edition's online chat feature. Access HP Instant Support Professional 
Edition at: www.hp.com/go/ispe.

Access the Business Support Center (BSC) at 
www.hp.com/go/bizsupport for the latest online support information, 
software and drivers, proactive notification, and worldwide 
community of peers and HP experts.

If it becomes necessary to call for technical assistance, be prepared to 
do the following to ensure that your service call is handled properly:

■ Be in front of your computer when you call.

■ Write down the computer serial number and product ID number, 
and the monitor serial number before calling.

■ Spend time troubleshooting the problem with the service 
technician.

■ Remove any hardware that was recently added to your system.

■ Remove any software that was recently installed.

■ Run the Restore Plus! CD.

Ä
CAUTION: Running the Restore Plus! CD will erase all data on the hard 
drive.

✎ For sales information and warranty upgrades (Care Packs), call your 
local authorized service provider or dealer.
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Helpful Hints
If you encounter problems with the computer, monitor, or software, 
see the following list of general suggestions before taking further 
action:

■ Check that the computer and monitor are plugged into a working 
electrical outlet.

■ Check to see that the voltage select switch (some models) is set to 
the appropriate voltage for your region (115V or 230V).

■ Check to see that the computer is turned on and the green power 
light is on.

■ Check to see that the monitor is turned on and the green monitor 
light is on. 

■ Check the Power LED on the front of the computer to see if it is 
flashing red. The flashing lights are error codes that will help you 
diagnose the problem. Refer to Appendix A, “POST Error 
Messages” for more information.

■ Turn up the brightness and contrast controls of the monitor if the 
monitor is dim.

■ Press and hold any key. If the system beeps, then the keyboard 
should be operating correctly.

■ Check all cable connections for loose connections or incorrect 
connections.

■ Wake the computer by pressing any key on the keyboard or 
pressing the power button. If the system remains in suspend 
mode, shut down the computer by pressing and holding the power 
button for at least four seconds then press the power button again 
to restart the computer. If the system will not shut down, unplug 
the power cord, wait a few seconds, then plug it in again. The 
computer will restart if automatic start on power loss is set in 
Computer Setup. If it does not restart, press the power button to 
start the computer.

■ Reconfigure the computer after installing a non–plug and play 
expansion board or other option. See “Solving Hardware 
Installation Problems” for instructions.
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■ Be sure that all the needed device drivers have been installed. For 
example, if you are using a printer, you need a driver for that 
model printer.

■ Remove all bootable media (diskette, CD, or USB device) from 
the system before turning it on.

■ If you have installed an operating system other than the 
factory-installed operating system, check to be sure that it is 
supported on the system.

■ If the system has multiple video sources (embedded, PCI, or 
PCI-Express adapters) installed (embedded video on select 
models only) and a single monitor, the monitor must be plugged 
into the monitor connector on the source selected as the primary 
VGA adapter. During boot, the other monitor connectors are 
disabled and if the monitor is connected into these ports, the 
monitor will not function. You can select which source will be the 
default VGA source in Computer Setup.

Ä
CAUTION: When the computer is plugged into an AC power source, 
there is always voltage applied to the system board. You must disconnect 
the power cord from the power source before opening the computer to 
prevent system board or component damage.
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Solving General Problems
You may be able to easily resolve the general problems described in 
this section. If a problem persists and you are unable to resolve it 
yourself or if you feel uncomfortable about performing the operation, 
contact an authorized dealer or reseller.

Solving General Problems 
Problem Cause Solution

Computer appears 
locked up and will not 
turn off when the power 
button is pressed.

Software control of the 
power switch is not 
functional.

Press and hold the power button for at 
least four seconds until the computer 
turns off.

Computer will not 
respond to USB 
keyboard or mouse.

Computer is in 
standby mode.

Press the power button to resume from 
standby mode.

System has locked up. Restart computer.

Ä CAUTION: When attempting to resume from standby mode, do not hold down the 
power button for more than four seconds. Otherwise, the computer will shut down and 
you will lose your data.

Computer date and 
time display is incorrect.

RTC (real-time clock) 
battery may need to be 
replaced. 

✎ Connecting the 
computer to a live 
AC outlet prolongs 
the life of the 
RTC battery.

First, reset the date and time under 
Control Panel (Computer Setup can 
also be used to update the RTC date 
and time). If the problem persists, 
replace the RTC battery. See the 
Hardware Reference Guide on the 
Documentation CD for instructions on 
installing a new battery, or contact an 
authorized dealer or reseller for RTC 
battery replacement.

Cursor will not move 
using the arrow keys on 
the keypad.

The Num Lock key 
may be on.

Press the Num Lock key. The 
Num Lock light should not be on if 
you want to use the arrow keys. The 
Num Lock key can be disabled (or 
enabled) in Computer Setup.
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Cannot remove 
computer cover or 
access panel.

Smart Cover Lock, 
featured on some 
computers, is locked.

Unlock the Smart Cover Lock using 
Computer Setup.
The Smart Cover FailSafe Key, a 
device for manually disabling the 
Smart Cover Lock, is available from 
HP. You will need the FailSafe Key in 
case of forgotten password, power 
loss, or computer malfunction. Order 
PN 166527-001 for the wrench-style 
key or PN 166527-002 for the 
screwdriver bit key.

Poor performance is 
experienced.

Processor is hot. 1. Make sure the airflow to the 
computer is not blocked.

2. Make sure the fans are connected 
and working properly (some fans 
only operate when needed).

3. Make sure the processor heatsink 
is installed properly.

Hard drive is full. Transfer data from the hard drive to 
create more space on the hard drive.

Low on memory. Add more memory.

Hard drive fragmented. Defragment hard drive. 

Program previously 
accessed did not release 
reserved memory back to 
the system.

Restart the computer.

Virus resident on the hard 
drive.

Run virus protection program.

Too many applications 
running.

1. Close unnecessary applications 
to free up memory.

2. Add more memory.

Cause unknown. Restart the computer.

Solving General Problems (Continued)

Problem Cause Solution
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Computer powered off 
automatically and the 
Power LED flashes Red 
two times, once every 
second, followed by a 
two second pause, and 
the computer beeps two 
times.

Processor thermal 
protection activated:
A fan may be blocked or 
not turning.
OR 
The heatsink is not 
properly attached to the 
processor.

1. Ensure that the computer air vents 
are not blocked and the 
processor cooling fan is running.

2. Open hood, press power button, 
and see if the processor fan 
spins. If the processor fan is not 
spinning, make sure the fan's 
cable is plugged onto the system 
board header. Ensure the fan is 
fully/properly seated or installed.

3. If fan is plugged in and seated 
properly, but is not spinning, then 
replace the processor fan.

4. Reseat processor heatsink and 
verify that the fan assembly is 
properly attached.

5. Contact an authorized reseller or 
service provider.

Solving General Problems (Continued)

Problem Cause Solution
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System does not power 
on and the LEDs on the 
front of the computer 
are not flashing.

System unable to power 
on.

Press and hold the power button for 
less than 4 seconds. If the hard drive 
LED turns green, then:
1. Check that the voltage selector, 

located on the rear of the power 
supply on select models, is set to 
the appropriate voltage. Proper 
voltage setting depends on your 
region.

2. Remove the expansion cards one 
at a time until the 5V_aux light on 
the system board turns on.

3. Replace the system board.
OR
Press and hold the power button for 
less than 4 seconds. If the hard drive 
LED does not turn on green then:
1. Check that the unit is plugged 

into a working AC outlet.
2. Open hood and check that the 

power button harness is properly 
connected to the system board.

3. Check that both power supply 
cables are properly connected to 
the system board.

4. Check to see if the 5V_aux light 
on the system board is turned on. 
If it is turned on, then replace the 
power button harness.

5. If the 5V_aux light on the system 
board is not turned on, then 
replace the power supply.

6. Replace the system board.

Solving General Problems (Continued)

Problem Cause Solution
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Solving Power Supply Problems
Common causes and solutions for power supply problems are listed in 
the following table.

Solving Power Supply Problems 
Problem Cause Solution

Power supply shuts down 
intermittently.

Voltage selector switch 
on rear of computer 
chassis (some models) 
not switched to correct 
line voltage (115V or 
230V).

Select the proper AC voltage using 
the selector switch.

Power supply will not 
turn on because of 
internal power supply 
fault.

Contact an authorized service 
provider to replace the power 
supply.

Computer powered off 
automatically and the 
Power LED flashes Red two 
times, once every second, 
followed by a two second 
pause, and the computer 
beeps two times.

Processor thermal 
protection activated:
A fan may be blocked 
or not turning.
OR 
The heatsink is not 
properly attached to the 
processor.

1. Ensure that the computer air 
vents are not blocked and the 
processor cooling fan is running.

2. Open hood, press power button, 
and see if the processor fan 
spins. If the processor fan is not 
spinning, make sure the fan's 
cable is plugged onto the system 
board header. Ensure the fan is 
fully/properly seated or 
installed.

3. If fan is plugged in and seated 
properly, but is not spinning, 
then replace the processor fan.

4. Reseat processor heatsink and 
verify that the fan assembly is 
properly attached.

5. Contact an authorized reseller or 
service provider.
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Power LED flashes Red four 
times, once every second, 
followed by a two second 
pause, and the computer 
beeps four times.

Power failure (power 
supply is overloaded).

1. Check that the voltage selector, 
located on the rear of the power 
supply (some models), is set to 
the appropriate voltage. Proper 
voltage setting depends on your 
region.

2. Open the hood and ensure the 
4-wire power supply cable is 
seated into the connector on the 
system board.

3. Check if a device is causing the 
problem by removing ALL 
attached devices (such as hard, 
diskette, or optical drives, and 
expansion cards). Power on the 
system. If the system enters the 
POST, then power off and 
replace one device at a time 
and repeat this procedure until 
failure occurs. Replace the 
device that is causing the failure. 
Continue adding devices one at 
a time to ensure all devices are 
functioning properly.

4. Contact an authorized service 
provider to replace the power 
supply.

5. Replace the system board.

Solving Power Supply Problems (Continued)

Problem Cause Solution
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Solving Diskette Problems
Common causes and solutions for diskette problems are listed in the 
following table.

✎ You may need to reconfigure the computer when you add or remove 
hardware, such as an additional diskette drive. See “Solving 
Hardware Installation Problems” for instructions.

Solving Diskette Problems 
Problem Cause Solution

Diskette drive light stays on. Diskette is damaged. In Microsoft Windows XP, right-click 
Start, click Explore, and select a 
drive. Select File > Properties > 
Tools. Under Error-checking, 
click Check Now.

Diskette is incorrectly 
inserted.

Remove diskette and reinsert.

Drive cable is not 
properly connected.

Reconnect drive cable. Ensure that 
all four pins on the diskette power 
cable are connected to the drive.

Drive not found. Cable is loose. Reseat diskette drive data and 
power cable.

Removable drive is not 
seated properly.

Reseat the drive.

Diskette drive cannot write 
to a diskette.

Diskette is not 
formatted.

Format the diskette.
1. From Windows Explorer select 

the disk (A) drive.
2. Right-click the drive letter and 

select Format.
3. Select the desired options, and 

click Start to begin formatting 
the diskette.

Diskette is 
write-protected.

Use another diskette or remove the 
write protection.
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Diskette drive cannot write 
to a diskette. (continued)

Writing to the wrong 
drive.

Check the drive letter in the path 
statement.

Not enough space is 
left on the diskette.

1. Use another diskette.
2. Delete unneeded files from 

diskette.

Legacy diskette writes 
are disabled in 
Computer Setup.

Enter Computer Setup and enable 
Legacy Diskette Write in 
Storage > Storage Options.

Diskette is damaged. Replace the damaged disk.

Cannot format diskette. Invalid media reported. When formatting a disk in MS-DOS, 
you may need to specify diskette 
capacity. For example, to format a 
1.44-MB diskette, type the following 
command at the MS-DOS prompt:

FORMAT A: /F:1440

Disk may be 
write-protected.

Open the locking device on the 
diskette.

Diskette write control is 
enabled.

Enter Computer Setup and enable 
Legacy Diskette Write in 
Storage > Storage Options.

A problem has occurred 
with a disk transaction.

The directory structure is 
bad, or there is a 
problem with a file.

In Windows XP, right-click Start, 
click Explore, and select a drive. 
Select File > Properties > 
Tools. Under Error-checking, 
click Check Now.

Diskette drive cannot read 
a diskette.

You are using the wrong 
diskette type for the 
drive type.

Check the type of drive that you 
are using and use the correct 
diskette type.

You are reading the 
wrong drive.

Check the drive letter in the path 
statement.

Diskette is damaged. Replace the diskette with a new one.

Solving Diskette Problems (Continued)

Problem Cause Solution
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“Invalid system disk” 
message is displayed.

A diskette that does not 
contain the system files 
needed to start the 
computer has been 
inserted in the drive.

When drive activity stops, remove 
the diskette and press the 
Spacebar. The computer should 
start up.

Diskette error has 
occurred.

Restart the computer by pressing the 
power button.

Cannot Boot to Diskette. Diskette is not bootable. Replace with a bootable diskette.

Diskette boot has been 
disabled in Computer 
Setup.

1. Run Computer Setup and 
enable diskette boot in 
Storage > Boot Order.

2. Run Computer Setup and 
enable diskette boot in 
Storage > Storage 
Options > Removable 
Media Boot.

✎ Both steps should be used as 
the Removable Media 
Boot function in Computer 
Setup overrides the Boot 
Order enable command.

Network server mode is 
enabled in Computer 
Setup.

Run Computer Setup and disable 
Network Server Mode in 
Security > Password Options.

Removable media boot 
has been disabled in 
Computer Setup.

Run Computer Setup and enable 
Removable Media Boot in 
Storage > Storage Options > 
Removable Media Boot.

Solving Diskette Problems (Continued)

Problem Cause Solution
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Solving Hard Drive Problems

Solving Hard Drive Problems 
Problem Cause Solution

Hard drive error occurs. Hard disk has bad 
sectors or has failed.

1. In Windows XP, right-click 
Start, click Explore, and 
select a drive. Select File > 
Properties > Tools. Under 
Error-checking, click Check 
Now.

2. Use a utility to locate and block 
usage of bad sectors. If 
necessary, reformat the hard 
disk.

Disk transaction problem. Either the directory 
structure is bad or there 
is a problem with a file.

In Windows XP, right-click Start, 
click Explore, and select a drive. 
Select File > Properties > Tools. 
Under Error-checking, click 
Check Now.

Drive not found (identified). Cable could be loose. Check cable connections.

The system may not 
have automatically 
recognized a newly 
installed device.

See reconfiguration directions in the 
“Solving Hardware Installation 
Problems” section. If the system still 
does not recognize the new device, 
check to see if the device is listed 
within Computer Setup. If it is listed, 
the probable cause is a driver 
problem. If it is not listed, the 
probable cause is a hardware 
problem.
If this is a newly installed drive, enter 
Computer Setup and try adding a 
POST delay under Advanced > 
Power-On.
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Drive not found (identified). 
(continued)

Drive jumper settings 
may be incorrect.

If the drive is a Master drive, set the 
jumper on the back of the drive to 
Master or Cable Select. If the drive 
is a Slave drive, set the jumper to 
Slave or Cable Select.

Drive’s controller is 
disabled in Computer 
Setup.

Run Computer Setup and enable all 
the IDE and SATA controllers in 
Storage > Storage Options.

Drive responds slowly 
immediately after 
power-up.

Run Computer Setup and increase 
the POST Delay in Advanced > 
Power-On Options.

Nonsystem disk/NTLDR 
missing message.

The system is trying to 
start from a diskette that 
is not bootable.

Remove the diskette from the diskette 
drive.

The system is trying to 
start from the hard drive 
but the hard drive may 
have been damaged.

1. Insert a bootable diskette into 
the diskette drive and restart the 
computer.

2. Check the hard drive format 
using fdisk: 
If NTFS formatting, use a third 
party reader to evaluate the 
drive. 
If FAT32 formatting, the hard 
drive cannot be accessed. 
Replace the MBR image.

3. If the hard drive is still 
inaccessible after booting to a 
diskette and MBR Security is 
enabled, you may try restoring 
the previously saved 
MBR image. To do so, enter 
Computer Setup and select 
Security > Restore Master 
Boot Record.

Solving Hard Drive Problems (Continued)

Problem Cause Solution
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Nonsystem disk/NTLDR 
missing message. 
(continued)

System files missing or 
not properly installed.

1. Insert a bootable diskette into 
the diskette drive and restart the 
computer.

2. Check the hard drive format 
using Fdisk: 
If NFTFS formatting, use a third 
party reader to evaluate the 
drive. 
If FAT32 formatting, the hard 
drive cannot be accessed. 
Replace the MBR image.

3. If the hard drive is still 
inaccessible after booting to a 
diskette and MBR Security is 
enabled, you may try restoring 
the previously saved 
MBR image. To do so, enter 
Computer Setup and select 
Security > Restore Master 
Boot Record.

Hard drive boot has 
been disabled in 
Computer Setup.

Run Computer Setup and enable the 
hard drive entry in the Storage > 
Boot Order list.

Bootable hard drive is 
not attached as first in a 
multi-hard drive 
configuration.

If attempting to boot from an IDE 
hard drive, ensure it is attached as 
Primary Device 0. If attempting to 
boot from a SATA hard drive, ensure 
it is attached to SATA 0.

Bootable hard drive's 
controller is not listed 
first in the Boot Order.

Enter Computer Setup and select 
Storage > Boot Order and 
ensure the bootable hard drive's 
controller is listed immediately under 
the Hard Drive entry.

Solving Hard Drive Problems (Continued)

Problem Cause Solution
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Solving MultiBay Problems

Parallel ATA (PATA) hard 
drive does not perform 
optimally.

You are using the wrong 
cable for the drive type.

Reinstall the Ultra ATA hard drive 
using an 80-conductor cable.

Computer will not start. Hard drive is damaged. Observe if the front panel Power 
LED is blinking RED and if any 
beeps are heard. See Appendix A, 
“POST Error Messages” to 
determine possible causes for the 
blinking red and beep codes.
See the Worldwide Limited 
Warranty for terms and conditions.

Computer seems to be 
locked up.

Program in use has 
stopped responding to 
commands.

Attempt the normal Windows “Shut 
Down” procedure. If this fails, press 
the power button for four or more 
seconds to turn off the power. To 
restart the computer, press the 
power button again.

Solving Hard Drive Problems (Continued)

Problem Cause Solution

Solving MultiBay Problems
Problem Cause Solution

Drive not found. You attempted to hot 
plug a removable 
hard drive that has 
DriveLock security 
enabled. (This feature 
supported on select 
models only.)

Shut down Windows and turn off 
the computer. Insert the drive into 
the MultiBay, if it is not already 
inserted. Turn on the computer.

MultiBay is hidden in 
Computer Setup.

Enter Computer Setup and set 
MultiBay to Device Available in 
Security > Device Security.
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Solving Display Problems
If you encounter display problems, see the documentation that came 
with the monitor and to the common causes and solutions listed in the 
following table.

Solving Display Problems 
Problem Cause Solution

Blank screen (no video). Monitor is not turned on 
and the monitor light is 
not on.

Turn on the monitor and check that 
the monitor light is on.

Bad monitor. Try a different monitor.

The cable connections 
are not correct.

Check the cable connection from the 
monitor to the computer and to the 
electrical outlet.

You may have a screen 
blanking utility installed 
or energy saver features 
are enabled.

Press any key or click the mouse 
button and, if set, type your 
password.

System ROM is bad; 
system is running in 
FailSafe Boot Block 
mode (indicated by 
eight beeps).

Reflash the ROM using a ROMPaq 
diskette. See the “FailSafe Boot 
Block ROM” section of the Desktop 
Management Guide on the 
Documentation CD for more 
information.

You are using a 
fixed-sync monitor and 
it will not sync at the 
resolution chosen.

Be sure that the monitor can accept 
the same horizontal scan rate as the 
resolution chosen.

Computer is in 
standby mode.

Press the power button to resume 
from standby mode.

Ä CAUTION: When attempting to resume from standby mode, do not hold down the 
power button for more than four seconds. Otherwise, the computer will shut down and 
you will lose your data.
Troubleshooting Guide www.hp.com 2–19



Troubleshooting Without Diagnostics
Blank screen (no video). 
(continued)

Monitor cable is 
plugged into the wrong 
connector.

If the computer system has both 
an integrated graphics connector 
and an add-in graphics card 
connector, plug the monitor cable 
into the graphics card connector on 
the back of the computer.

✎ If the graphics card is a standard 
PCI expansion card, you can 
enable the integrated graphics in 
Computer Setup. If a PCI-Express 
graphics card is installed, the 
integrated graphics can not be 
enabled.

Monitor settings in the 
computer are not 
compatible with the 
monitor.

1. Restart the computer and press 
F8 during startup when you see 
“Press F8” in the bottom right 
corner of the screen.

2. Using the keyboard arrow keys, 
select Enable VGA Mode 
and press Enter.

3. In Windows Control Panel, 
double-click the Display icon 
and select the Settings tab.

4. Use the sliding control to reset 
the resolution.

Blank screen and the 
power LED flashes Red five 
times, once every second, 
followed by a two second 
pause, and the computer 
beeps five times.

Pre-video memory error. 1. Reseat DIMMs. Power on the 
system.

2. Replace DIMMs one at a time to 
isolate the faulty module.

3. Replace third-party memory 
with HP memory.

4. Replace the system board.

Solving Display Problems (Continued)

Problem Cause Solution
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Blank screen and the 
power LED flashes Red six 
times, once every second, 
followed by a two second 
pause, and the computer 
beeps six times.

Pre-video graphics 
error.

For systems with a graphics card:
1. Reseat the graphics card. 

Power on the system.
2. Replace the graphics card.
3. Replace the system board.

For systems with integrated 
graphics, replace the system board.

Blank screen and the 
power LED flashes Red 
seven times, once every 
second, followed by a two 
second pause, and the 
computer beeps seven 
times.

System board failure 
(ROM detected failure 
prior to video).

Replace the system board.

Monitor does not function 
properly when used with 
energy saver features.

Monitor without energy 
saver capabilities is 
being used with energy 
saver features enabled.

Disable monitor energy saver 
feature.

Dim characters. The brightness and 
contrast controls are not 
set properly.

Adjust the monitor brightness and 
contrast controls.

Cables are not properly 
connected.

Check that the graphics cable is 
securely connected to the graphics 
card and the monitor.

Blurry video or requested 
resolution cannot be set.

If the graphics controller 
was upgraded, the 
correct graphics drivers 
may not be loaded.

Install the video drivers included in 
the upgrade kit.

Monitor is not capable 
of displaying requested 
resolution.

Change requested resolution.

Graphics card is bad. Replace the graphics card.

Solving Display Problems (Continued)

Problem Cause Solution
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The picture is broken up, 
rolls, jitters, or flashes.

The monitor 
connections may be 
incomplete or the 
monitor may be 
incorrectly adjusted.

1. Be sure the monitor cable is 
securely connected to the 
computer.

2. In a two-monitor system or if 
another monitor is in close 
proximity, be sure the monitors 
are not interfering with each 
other’s electromagnetic field by 
moving them apart.

3. Fluorescent lights or fans may 
be too close to the monitor.

Monitor needs to be 
degaussed.

Degauss the monitor. Refer to the 
documentation that came with the 
monitor for instructions.

Vibrating or rattling noise 
coming from inside a CRT 
monitor when powered on.

Monitor degaussing 
coil has been activated.

None. It is normal for the 
degaussing coil to be activated 
when the monitor is powered on.

Clicking noise coming from 
inside a CRT monitor.

Electronic relays have 
been activated inside 
the monitor.

None. It is normal for some 
monitors to make a clicking noise 
when turned on and off, when 
going in and out of standby mode, 
and when changing resolutions.

High pitched noise coming 
from inside a flat panel 
monitor.

Brightness and/or 
contrast settings are too 
high.

Lower brightness and/or contrast 
settings.

Solving Display Problems (Continued)

Problem Cause Solution
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Fuzzy focus; streaking, 
ghosting, or shadowing 
effects; horizontal scrolling 
lines; faint vertical bars; or 
unable to center the picture 
on the screen. 
(flat panel monitors using 
an analog VGA input 
connection only)

Flat panel monitor’s 
internal digital 
conversion circuits may 
be unable to correctly 
interpret the output 
synchronization of the 
graphics card.

1. Select the monitor’s 
Auto-Adjustment option in the 
monitor’s on-screen display 
menu.

2. Manually synchronize the Clock 
and Clock Phase on-screen 
display functions. To download 
a SoftPaq that will assist you 
with the synchronization, go to 
the following Web site, select 
the appropriate monitor, and 
download either SP20930 or 
SP22333: 
www.hp.com/support

Graphics card is not 
seated properly or is 
bad.

1. Reseat the graphics card.
2. Replace the graphics card.

Certain typed symbols do 
not appear correct.

The font you are using 
does not support that 
particular symbol.

Use the Character Map to locate the 
and select the appropriate symbol. 
Click Start > All Programs > 
Accessories > System Tools > 
Character Map. You can copy 
the symbol from the Character Map 
into a document.

Solving Display Problems (Continued)

Problem Cause Solution
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Solving Audio Problems
If the computer has audio features and you encounter audio problems, 
see the common causes and solutions listed in the following table.

Solving Audio Problems 
Problem Cause Solution

Sound cuts in and out. Processor resources are 
being used by other 
open applications.

Shut down all open 
processor-intensive applications.

Direct sound latency, 
common in many media 
player applications.

In Windows XP:
1. From the Control Panel, select 

Sounds and Audio 
Devices.

2. On the Audio tab, select a 
device from the Sound 
Playback list.

3. Click the Advanced button 
and select the Performance 
tab.

4. Set the Hardware 
acceleration slider to None 
and the Sample rate 
conversion quality slider to 
Good and retest the audio.

Set the Hardware acceleration 
slider to Full and the Sample rate 
conversion quality slider to 
Best and retest the audio.

Sound does not come 
out of the speaker or 
headphones.

Software volume control 
is turned down.

Double-click the Speaker icon on 
the taskbar, then make sure that 
Mute is not selected and use the 
volume slider to adjust the volume.

Audio is hidden in 
Computer Setup.

Enable the audio in Computer 
Setup: Security > 
Device Security > Audio.
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Sound does not come 
out of the speaker or 
headphones. (continued)

The external speakers 
are not turned on.

Turn on the external speakers.

External speakers 
plugged into the wrong 
audio jack.

See the sound card documentation 
for proper speaker connection.

Digital CD audio is not 
enabled.

Enable digital CD audio:
1. From the Control Panel, select 

System.
2. On the Hardware tab, click 

the Device Manager button.
3. Right-click on the CD/DVD 

device and select Properties.
4. On the Properties tab, make 

sure “Enable digital CD 
audio for this CD-ROM 
device” is checked.

Headphones or devices 
connected to the 
line-out connector mute 
the internal speaker.

Turn on and use headphones or 
external speakers, if connected, or 
disconnect headphones or external 
speakers.

Volume is muted. 1. From the Control Panel 
program, click Sound, 
Speech and Audio 
Devices, then click Sounds 
and Audio Devices.

2. Click the Mute check box to 
remove the check mark from 
the box.

Computer is in 
standby mode.

Press the power button to resume 
from standby mode.

Ä CAUTION: When attempting to resume from standby mode, do not hold down the 
power button for more than four seconds. Otherwise, the computer will shut down and 
you will lose your data.

Solving Audio Problems (Continued)

Problem Cause Solution
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Noise or no sound comes 
out of the speakers or 
headphones.

Computer may not be 
detecting the correct 
speaker/headphone 
type or output or 
analog-to-digital 
auto-sense is not 
engaged.

1. If you are using digital speakers 
that have a stereo jack and 
want the system to auto-switch to 
digital, use a stereo-to-mono 
adapter to properly engage the 
auto-sense feature.

2. If a stereo-to-mono adapter 
is not available, use the 
multimedia device properties 
to manually switch the audio 
signal from analog to digital.

3. If the headphones have a mono 
jack, use the multimedia device 
properties to switch the system 
to analog out.

For information on how to change 
the Audio Output Mode, see 
Appendix D, “Setting up 
Analog/Digital Audio Output.” 

✎ If you set digital as the Output Mode, the internal speaker and external analog 
speakers will no longer output audio until you switch back to an auto-sense or  
analog mode. 
 
If you set analog as the Output Mode, external digital speakers will not function 
until you change the output mode back to an auto-sense or digital mode. 
 
See Appendix D, “Setting up Analog/Digital Audio Output” for additional 
information.

Computer appears to be 
locked up while recording 
audio.

The hard disk may be 
full.

Before recording, make sure there is 
enough free space on the hard disk. 
You can also try recording the audio 
file in a compressed format.

Solving Audio Problems (Continued)

Problem Cause Solution
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Solving Printer Problems
If you encounter printer problems, see the documentation that came 
with the printer and to the common causes and solutions listed in the 
following table.

Solving Printer Problems 
Problem Cause Solution

Printer will not print. Printer is not turned on 
and online.

Turn the printer on and make sure it 
is online.

The correct printer 
drivers for the 
application are not 
installed.

1. Install the correct printer driver 
for the application.

2. Try printing using the 
MS-DOS command:
DIR C:\ > [printer port]
where [printer port] is the 
address of the printer being 
used. If the printer works, reload 
the printer driver.

If you are on a network, 
you may not have made 
the connection to the 
printer.

Make the proper network 
connections to the printer.

Printer may have failed. Run printer self-test.

Printer will not turn on. The cables may not be 
connected properly.

Reconnect all cables and check the 
power cord and electrical outlet.

Printer prints garbled 
information.

The correct printer 
driver for the 
application is not 
installed.

Install the correct printer driver for 
the application.

The cables may not be 
connected properly.

Reconnect all cables.

Printer memory may be 
overloaded.

Reset the printer by turning it off for 
one minute, then turn it back on.

Printer is offline. The printer may be out 
of paper.

Check the paper tray and refill it if 
it is empty. Select online.
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Solving Keyboard and Mouse Problems
If you encounter keyboard or mouse problems, see the documentation 
that came with the equipment and to the common causes and 
solutions listed in the following table.

Solving Keyboard Problems 
Problem Cause Solution

Keyboard commands and 
typing are not recognized 
by the computer.

Keyboard connector 
is not properly 
connected.

1. On the Windows Desktop, 
click Start.

2. Click Shut Down. The Shut 
Down Windows dialog box 
is displayed.

3. Select Shut down.
4. After the shutdown is complete, 

reconnect the keyboard to the 
back of the computer and 
restart the computer.

Program in use has 
stopped responding 
to commands.

Shut down your computer using 
the mouse and then restart the 
computer.

Keyboard needs 
repairs.

See the Worldwide Limited 
Warranty for terms and conditions.

Computer is in 
standby mode.

Press the power button to resume 
from standby mode.

Ä CAUTION: When attempting to resume from standby mode, do not hold down the 
power button for more than four seconds. Otherwise, the computer will shut down and 
you will lose your data.

Cursor will not move using 
the arrow keys on the 
keypad.

The Num Lock key 
may be on.

Press the Num Lock key. The 
Num Lock light should not be on if 
you want to use the arrow keys. The 
Num Lock key can be disabled  
(or enabled) in Computer Setup.
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Solving Mouse Problems 
Problem Cause Solution

Mouse does not respond to 
movement or is too slow.

Mouse connector is 
not properly plugged 
into the back of the 
computer.

Shut down the computer using the 
keyboard.
1. Press the Ctrl and Esc keys at 

the same time (or press the 
Windows logo key) to 
display the Start menu.

2. Use the up or down arrow key 
to select Shut Down and then 
press the Enter key.

3. Use the up or down arrow key 
to select the Shut Down 
option and then press the  
Enter key.

4. After the shutdown is complete, 
plug the mouse connector into 
the back of the computer (or the 
keyboard) and restart.

Program in use has 
stopped responding 
to commands.

Shut down the computer using the 
keyboard then restart the computer.

Mouse may need 
cleaning.

Remove the roller ball cover on the 
mouse and clean the internal 
components.

Mouse may need 
repair.

See the Worldwide Limited 
Warranty for terms and conditions.

Computer is in 
standby mode.

Press the power button to resume 
from standby mode.

Ä CAUTION: When attempting to resume from standby mode, do not hold down the 
power button for more than four seconds. Otherwise, the computer will shut down and 
you will lose your data.

Mouse will only move 
vertically, horizontally, or 
movement is jerky.

Mouse roller ball is 
dirty.

Remove roller ball cover from the 
bottom of the mouse and clean it 
with a mouse cleaning kit available 
from most computer stores.
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Solving Hardware Installation Problems
You may need to reconfigure the computer when you add or remove 
hardware, such as an additional drive or expansion card. If you install 
a plug and play device, Windows XP automatically recognize the 
device and configure the computer. If you install a non–plug and play 
device, you must reconfigure the computer after completing 
installation of the new hardware. In Windows XP, use the Add 
Hardware Wizard and follow the instructions that appear on the 
screen.

Solving Hardware Installation Problems 
Problem Cause Solution

A new device is not 
recognized as part of 
the system.

Device is not seated or 
connected properly. 

Ensure that the device is properly 
and securely connected and that 
pins in the connector are not 
bent down.

Cable(s) of new 
external device are 
loose or power cables 
are unplugged.

Ensure that all cables are properly 
and securely connected and that 
pins in the cable or connector are 
not bent down.

Power switch of new 
external device is not 
turned on.

Turn off the computer, turn on the 
external device, then turn on the 
computer to integrate the device 
with the computer system.

When the system 
advised you of changes 
to the configuration, you 
did not accept them.

Reboot the computer and follow the 
instructions for accepting the 
changes.

A plug and play board 
may not automatically 
configure when 
added if the default 
configuration conflicts 
with other devices.

Use Windows XP Device Manager 
to deselect the automatic settings for 
the board and choose a basic 
configuration that does not cause a 
resource conflict. You can also use 
Computer Setup to reconfigure or 
disable devices to resolve the 
resource conflict.
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Computer will not start. Wrong memory 
modules were used in 
the upgrade or memory 
modules were installed 
in the wrong location.

1. Review the documentation that 
came with the system to 
determine if you are using the 
correct memory modules and to 
verify the proper installation.

2. Observe the beeps and LED 
lights on the front of the 
computer. See Appendix A, 
“POST Error Messages” to 
determine possible causes.

3. If you still cannot resolve the 
issue, contact Customer 
Support.

Power LED flashes Red five 
times, once every second, 
followed by a two second 
pause, and the computer 
beeps five times.

Memory is installed 
incorrectly or is bad.

1. Reseat DIMMs. Power on the 
system.

2. Replace DIMMs one at a time to 
isolate the faulty module.

3. Replace third-party memory 
with HP memory.

4. Replace the system board.

Power LED flashes Red six 
times, once every second, 
followed by a two second 
pause, and the computer 
beeps six times.

Video card is not seated 
properly or is bad, or 
system board is bad.

For systems with a graphics card:
1. Reseat the graphics card. Power 

on the system.
2. Replace the graphics card.
3. Replace the system board.

For systems with integrated 
graphics, replace the system board.

Solving Hardware Installation Problems (Continued)

Problem Cause Solution
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Power LED flashes Red ten 
times, once every second, 
followed by a two second 
pause, and the computer 
beeps ten times.

Bad option card. 1. Check each option card by 
removing the cards one at time 
(if multiple cards), then power 
on the system to see if fault goes 
away.

2. Once bad card is identified, 
remove and replace bad option 
card.

3. Replace the system board.

Solving Hardware Installation Problems (Continued)

Problem Cause Solution
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Solving Network Problems
Some common causes and solutions for network problems are listed 
in the following table. These guidelines do not discuss the process of 
debugging the network cabling.

Solving Network Problems 
Problem Cause Solution

Wake-on-LAN feature is 
not functioning.

Wake-on-LAN is not 
enabled.

Enable Wake-on-LAN.
1. Select Start > Control 

Panel.
2. Double-click Network 

Connections.
3. Double-click Local Area 

Connection.
4. Click Properties.
5. Click Configure.
6. Click the Power 

Management tab, then 
select the check box to Allow 
this device to bring the 
computer out of standby.

Network driver does 
not detect network 
controller.

Network controller is 
disabled.

1. Run Computer Setup and 
enable network controller.

2. Enable the network controller in 
the operating system via Device 
Manager.

Incorrect network driver. Check the network controller 
documentation for the correct driver 
or obtain the latest driver from the 
manufacturer’s Web site.
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Network status link light 
never flashes.

✎ The network status 
light is supposed to 
flash when there is 
network activity.

No active network is 
detected.

Check cabling and network 
equipment for proper connection.

Network controller is not 
set up properly.

Check for the device status within 
Windows, such as Device Manager 
for driver load and the Network 
Connections applet within 
Windows for link status.

Network controller is 
disabled.

1. Run Computer Setup and 
enable network controller.

2. Enable the network controller in 
the operating system via Device 
Manager.

Network driver is not 
properly loaded.

Reinstall network drivers. See the 
Network & Internet 
Communications Guide on the 
Documentation CD.

System cannot autosense 
the network.

Disable auto-sensing capabilities 
and force the system into the correct 
operating mode. See the Network 
& Internet Communications Guide 
on the Documentation CD.

Diagnostics reports a 
failure.

The cable is not securely 
connected.

Ensure that the cable is securely 
attached to the network connector 
and that the other end of the cable 
is securely attached to the correct 
device.

The cable is attached to 
the incorrect connector.

Ensure that the cable is attached to 
the correct connector.

There is a problem with 
the cable or a device at 
the other end of the cable.

Ensure that the cable and device at 
the other end are operating 
correctly.

Network controller 
interrupt is shared with 
an expansion board.

Under the Computer Setup 
Advanced menu, change the 
resource settings for the board.

Solving Network Problems (Continued)

Problem Cause Solution
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Diagnostics reports a 
failure. (continued)

The network controller 
is defective.

Contact an authorized service 
provider.

Diagnostics passes, but 
the computer does not 
communicate with the 
network.

Network drivers are 
not loaded, or driver 
parameters do not match 
current configuration.

Make sure the network drivers 
are loaded and that the driver 
parameters match the configuration 
of the network controller.
Make sure the correct network client 
and protocol is installed.

The network controller 
is not configured for this 
computer.

Select the Network icon in the 
Control Panel and configure the 
network controller.

Network controller 
stopped working when 
an expansion board was 
added to the computer.

Network controller 
interrupt is shared with an 
expansion board.

Under the Computer Setup 
Advanced menu, change the 
resource settings for the board.

The network controller 
requires drivers.

Verify that the drivers were not 
accidentally deleted when the 
drivers for a new expansion board 
were installed.

The expansion board 
installed is a network card 
(NIC) and conflicts with 
the embedded NIC.

Under the Computer Setup 
Advanced menu, change the 
resource settings for the board.

Network controller stops 
working without apparent 
cause.

The files containing the 
network drivers are 
corrupted.

Reinstall the network drivers, using 
the Restore Plus! CD.

The cable is not securely 
connected.

Ensure that the cable is securely 
attached to the network connector 
and that the other end of the cable 
is securely attached to the correct 
device.

The network controller is 
defective.

Contact an authorized service 
provider.

Solving Network Problems (Continued)

Problem Cause Solution
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New network card will 
not boot.

New network card may be 
defective or may not meet 
industry-standard 
specifications.

Install a working, industry-standard 
NIC, or change the boot sequence 
to boot from another source.

Cannot connect to 
network server when 
attempting Remote 
System Installation.

The network controller is 
not configured properly.

Verify Network Connectivity, that a 
DHCP Server is present, and that 
the Remote System Installation 
Server contains the NIC drivers for 
your NIC.

System setup utility 
reports unprogrammed 
EEPROM.

Unprogrammed EEPROM. Contact an authorized service 
provider.

Solving Network Problems (Continued)

Problem Cause Solution
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Solving Memory Problems
If you encounter memory problems, some common causes and 
solutions are listed in the following table.

Ä
CAUTION: For those systems that support ECC memory, HP does not 
support mixing ECC and non-ECC memory. Otherwise, the computer will 
not boot the operating system.

Solving Memory Problems 
Problem Cause Solution

System will not boot or 
does not function properly 
after installing additional 
memory modules.

Memory module is not 
the correct type or 
speed grade for the 
system or the new 
memory module is 
not seated properly.

Replace module with the correct 
industry-standard device for the 
computer.

On some models, ECC and non-ECC 
memory modules cannot be mixed.

Out of memory error. Memory configuration 
may not be set up 
correctly.

Use the Device Manager to check 
memory configuration.

You have run out of 
memory to run the 
application.

Check the application 
documentation to determine the 
memory requirements.

Memory count during POST 
is wrong.

The memory modules 
may not be installed 
correctly.

Check that the memory modules 
have been installed correctly and 
that proper modules are used.

Integrated graphics may 
use system memory.

No action required.

Insufficient memory error 
during operation.

Too many Terminate 
and Stay Resident 
programs (TSRs) are 
installed.

Delete any TSRs that you do 
not need.

You have run out of 
memory for the 
application.

Check the memory requirements for 
the application or add more 
memory to the computer.
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Solving Processor Problems
If you encounter processor problems, common causes and solutions 
are listed in the following table.

Power LED flashes Red five 
times, once every second, 
followed by a two second 
pause, and the computer 
beeps five times.

Memory is installed 
incorrectly or is bad.

1. Reseat DIMMs. Power on the 
system.

2. Replace DIMMs one at a time to 
isolate the faulty module.

3. Replace third-party memory 
with HP memory.

4. Replace the system board.

Solving Memory Problems (Continued)

Problem Cause Solution

Solving Processor Problems
Problem Cause Solution

Poor performance is 
experienced.

Processor is hot. 1. Make sure the airflow to the 
computer is not blocked.

2. Make sure the fans are 
connected and working 
properly (some fans only 
operate when needed).

3. Make sure the processor 
heatsink is installed properly.

Power LED flashes Red 
three times, once every 
second, followed by a two 
second pause.

Processor is not seated 
properly or not 
installed.

1. Check to see that the processor 
is present.

2. Reseat the processor.
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Solving CD-ROM and DVD Problems
If you encounter CD-ROM or DVD problems, see the common 
causes and solutions listed in the following table or to the 
documentation that came with the optional device.

Solving CD-ROM and DVD Problems 
Problem Cause Solution

System will not boot from 
CD-ROM or DVD drive.

Removable Media Boot 
is disabled in the 
Computer Setup utility.

Run the Computer Setup utility and 
enable booting to removable media 
in Storage > Storage Options. 
Ensure IDE CD-ROM is enabled in 
Storage > Boot Order.

Network Server Mode 
is enabled in Computer 
Setup.

Run the Computer Setup utility and 
disable Network Server Mode in 
Security > Password Options.

Non-bootable CD in 
drive.

Try a bootable CD in the drive.

Boot order not correct. Run the Computer Setup utility 
and change boot sequence in 
Storage > Boot Order.

CD-ROM or DVD devices 
are not detected or driver is 
not loaded.

Drive is not connected 
properly or not properly 
configured.

See the documentation that came 
with the optional device.

Movie will not play in the 
DVD drive.

Movie may be 
regionalized for a 
different country.

See the documentation that came 
with the DVD drive.

Decoder software is not 
installed.

Install decoder software.

Damaged media. Replace media.

Movie rating locked out 
by parental lock.

Use DVD software to remove 
parental lock.

Media installed upside 
down.

Reinstall media.
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Cannot eject compact disc 
(tray-load unit).

Disc not properly seated 
in the drive.

Turn off the computer and insert a 
thin metal rod into the emergency 
eject hole and push firmly. Slowly 
pull the tray out from the drive until 
the tray is fully extended, then 
remove the disc.

CD-ROM, CD-RW, 
DVD-ROM, or DVD-R/RW 
drive cannot read a disc or 
takes too long to start.

Media has been 
inserted upside down.

Re-insert the Media with the label 
facing up.

The DVD-ROM drive 
takes longer to start 
because it has to 
determine the type of 
media played, such as 
audio or video.

Wait at least 30 seconds to let the 
DVD-ROM drive determine the type 
of media being played. If the disc 
still does not start, read the other 
solutions listed for this topic.

CD or DVD disc is dirty. Clean CD or DVD with a CD 
cleaning kit, available from most 
computer stores.

Windows does not 
detect the CD-ROM or 
DVD-ROM drive.

1. Use Device Manager to remove 
or uninstall the device in 
question.

2. Restart the computer and let 
Windows detect the CD or DVD 
driver.

Recording audio CDs is 
difficult or impossible.

Wrong or poor quality 
media type.

1. Try using a slower speed when 
recording.

2. Verify that you are using the 
correct media for the drive.

3. Try a different brand of media. 
Quality varies widely between 
manufacturers.

Solving CD-ROM and DVD Problems (Continued)

Problem Cause Solution
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Solving Drive Key Problems
If you encounter Drive Key problems, common causes and solutions 
are listed in the following table.

Solving Internet Access Problems
If you encounter Internet access problems, consult your Internet 
Service Provider (ISP) or refer to the common causes and solutions 
listed in the following table.

Solving Drive Key Problems
Problem Cause Solution

Drive Key is not seen as a 
drive letter in Windows XP.

The drive letter after the 
last physical drive is not 
available.

Change the default drive letter for 
the Drive Key in Windows XP.

The computer boots to DOS 
after making a bootable 
Drive Key.

Drive Key is bootable. Install the Drive Key only after the 
operating system boots.

Solving Internet Access Problems 
Problem Cause Solution

Unable to connect to the 
Internet.

Internet Service Provider 
(ISP) account is not set 
up properly.

Verify Internet settings or contact 
your ISP for assistance.

Modem is not set up 
properly.

Reconnect the modem. Verify the 
connections are correct using the 
quick setup documentation.

Web browser is not set 
up properly.

Verify that the Web browser is 
installed and set up to work with 
your ISP.

Cable/DSL modem is 
not plugged in.

Plug in cable/DSL modem. You 
should see a “power” LED light on 
the front of the cable/DSL modem.
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Unable to connect to the 
Internet. (continued)

Cable/DSL service is 
not available or has 
been interrupted due to 
bad weather.

Try connecting to the Internet at a 
later time or contact your ISP. (If the 
cable/DSL service is connected, the 
“cable” LED light on the front of the 
cable/DSL modem will be on.)

The CAT5 UTP cable is 
disconnected.

Connect the CAT5 UTP cable 
between the cable modem and the 
computers’s RJ-45 connector. (If the 
connection is good, the “PC” LED 
light on the front of the cable/DSL 
modem will be on.)

IP address is not 
configured properly.

Contact your ISP for the correct IP 
address.

Cookies are corrupted. 
(A "cookie" is a small 
piece of information 
that a Web server can 
store temporarily with 
your Web browser. This 
is useful for having your 
browser remember 
some specific 
information that the 
Web server can later 
retrieve.)

In Windows XP:
1. Select Start > Control 

Panel.
2. Double-click Internet 

Options.
3. On the General tab, click the 

Delete Cookies button.

Cannot automatically 
launch Internet programs.

You must log on to your 
ISP before some 
programs will start.

Log on to your ISP and launch the 
desired program.

Solving Internet Access Problems (Continued)

Problem Cause Solution
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Internet takes too long to 
download Web sites.

Modem is not set up 
properly.

Verify that the correct modem speed 
and COM port are selected.
In Windows XP:
1. Select Start > Control 

Panel.
2. Double-click System.
3. Click the Hardware tab.
4. In the Device Manager area, 

click the Device Manager 
button.

5. Double-click Ports (COM & 
LPT).

6. Right-click the COM port your 
modem uses, then click 
Properties.

7. Under Device status, verify 
that the modem is working 
properly.

8. Under Device usage, verify 
the modem is enabled.

9. If there are further problems, 
click the Troubleshoot button 
and follow the on-screen 
instructions.

Solving Internet Access Problems (Continued)

Problem Cause Solution
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Solving Software Problems
Most software problems occur as a result of the following:

■ The application was not installed or configured correctly.

■ There is insufficient memory available to run the application.

■ There is a conflict between applications.

■ Be sure that all the needed device drivers have been installed.

■ If you have installed an operating system other than the 
factory-installed operating system, check to be sure it is 
supported on the system.

Where available, run the Configuration Record utility to determine if 
any changes have been made to the software which may be causing a 
problem. Refer to the “Configuration Record” section in this guide 
for more information.

If you encounter software problems, see the applicable solutions 
listed in the following table.

Solving Software Problems 
Problem Cause Solution

Computer will not continue 
and no HP logo screen has 
appeared.

POST error has 
occurred.

Observe the beeps and LED lights 
on the front of the computer.  
See Appendix A, “POST Error 
Messages” to determine possible 
causes.
See the Restore Kit or the Worldwide 
Limited Warranty for terms and 
conditions.

Computer will not continue 
after HP logo screen has 
appeared.

System files may be 
damaged.

Use recovery diskette to scan hard 
drive for errors.
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Contacting Customer Support
For help and service, contact an authorized reseller or dealer. To 
locate a reseller or dealer near you, visit www.hp.com.

✎ If you take the computer to an authorized reseller, dealer, or service 
provider for service, remember to provide the setup and power-on 
passwords if they are set.

✎ Refer to the number listed in the warranty or in the Support 
Telephone Numbers guide on the Documentation CD for technical 
assistance.

“Illegal Operation has 
Occurred” error message is 
displayed.

Software being used is 
not Microsoft-certified 
for your version of 
Windows.

Verify that the software is certified 
by Microsoft for your version of 
Windows (see program packaging 
for this information).

Configuration files are 
corrupt.

If possible, save all data, close all 
programs, and restart the computer.

Solving Software Problems (Continued)

Problem Cause Solution
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A
POST Error Messages

This appendix lists the error codes, error messages, and the various 
indicator light and audible sequences that you may encounter during 
Power-On Self-Test (POST) or computer restart, the probable source 
of the problem, and steps you can take to resolve the error condition.

POST Message Disabled suppresses most system messages during 
POST, such as memory count and non-error text messages. If a POST 
error occurs, the screen will display the error message. To manually 
switch to the POST Messages Enabled mode during POST, press any 
key (except F10 or F12). The default mode is POST Message 
Disabled.

The speed at which the computer loads the operating system and the 
extent to which it is tested are determined by the POST mode 
selection.

Quick Boot is a fast startup process that does not run all of the system 
level tests, such as the memory test. Full Boot runs all of the 
ROM-based system tests and takes longer to complete.

Full Boot may also be enabled to run every 1 to 30 days on a regularly 
scheduled basis. To establish the schedule, reconfigure the computer 
to the Full Boot Every x Days mode, using Computer Setup.

✎ For more information on Computer Setup, see the Computer Setup 
(F10) Utility Guide on the Documentation CD.
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POST Numeric Codes and Text Messages
This section covers those POST errors that have numeric codes 
associated with them. The section also includes some text messages 
that may be encountered during POST.

✎ The computer will beep once after a POST text message is displayed 
on the screen.

Numeric Codes and Text Messages 
Code/Message Probable Cause Recommended Action

101-Option ROM 
Checksum Error

System ROM or 
expansion board option 
ROM checksum.

1. Verify the correct ROM.
2. Flash the ROM if needed.
3. If an expansion board was recently 

added, remove it to see if the problem 
remains.

4. Clear CMOS. (See Appendix B, 
“Password Security and Resetting 
CMOS.”)

5. If the message disappears, there may 
be a problem with the expansion 
card.

6. Replace the system board.

102-System Board 
Failure

DMA or timers. 1. Clear CMOS. (See Appendix B, 
“Password Security and Resetting 
CMOS.”)

2. Remove expansion boards.
3. Replace the system board.

103-System Board 
Failure

DMA or timers. 1. Clear CMOS. (See Appendix B, 
“Password Security and Resetting 
CMOS.”)

2. Remove expansion boards.
3. Replace the system board.
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110-Out of Memory 
Space for Option 
ROMs

Recently added PCI 
expansion card contains 
an option ROM too large 
to download during 
POST.

1. If a PCI expansion card was recently 
added, remove it to see if the problem 
remains.

2. In Computer Setup, set Advanced > 
Device Options > NIC PXE 
Option ROM Download to 
DISABLE to prevent PXE option ROM 
for the internal NIC from being 
downloaded during POST to free 
more memory for an expansion card's 
option ROM. Internal PXE option 
ROM is used for booting from the NIC 
to a PXE server.

3. Enable the ACPI/USB Buffers @ Top 
of Memory setting in Computer Setup.

150-SafePost Active A PCI expansion card is 
not responding.

1. Restart the computer.
2. Disable SafePost.
3. If the expansion card does not 

respond, replace the card.

162-System Options 
Not Set

Configuration incorrect.
RTC (real-time clock) 
battery may need to 
be replaced.

Run Computer Setup and check the 
configuration in Advanced > 
Onboard Devices.
Reset the date and time under Control 
Panel. If the problem persists, replace the 
RTC battery. See the Hardware Reference 
Guide on the Documentation CD for 
instructions on installing a new battery, or 
contact an authorized dealer or reseller 
for RTC battery replacement.

Numeric Codes and Text Messages (Continued)

Code/Message Probable Cause Recommended Action
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163-Time & Date 
Not Set

Invalid time or date in 
configuration memory.
RTC (real-time clock) 
battery may need to 
be replaced.

Reset the date and time under Control 
Panel (Computer Setup can also be 
used). If the problem persists, replace the 
RTC battery. See the Hardware Reference 
Guide on the Documentation CD for 
instructions on installing a new battery, or 
contact an authorized dealer or reseller 
for RTC battery replacement.

CMOS jumper may not 
be properly installed.

Check for proper placement of the CMOS 
jumper if applicable.

164-Memory Size 
Error

Memory amount has 
changed since the last 
boot (memory added or 
removed).

Press the F1 key to save the memory 
changes.

Memory configuration 
incorrect.

1. Run Computer Setup or Windows 
utilities.

2. Make sure the memory module(s) are 
installed properly.

3. If third-party memory has been 
added, test using HP-only memory.

4. Verify proper memory module type.

201-Memory Error RAM failure. 1. Run Computer Setup or Windows 
utilities.

2. Ensure memory modules are correctly 
installed.

3. Verify proper memory module type.
4. Remove and replace the memory 

module(s) one at a time to isolate the 
faulty module.

5. Replace faulty memory module(s).
6. If the error persists after replacing 

memory modules, replace the system 
board.

Numeric Codes and Text Messages (Continued)

Code/Message Probable Cause Recommended Action
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202-Memory Type 
Mismatch

Memory modules do not 
match each other.

Replace memory modules with matched 
sets.

213-Incompatible 
Memory Module in 
Memory Socket(s) X, 
X, ...

A memory module 
in memory socket 
identified in the error 
message is missing 
critical SPD information, 
or is incompatible with 
the chipset.

1. Verify proper memory module type.
2. Try another memory socket.
3. Replace DIMM with a module 

conforming to the SPD standard.

214-DIMM 
Configuration 
Warning

A specific error has 
occurred in a memory 
device installed in the 
identified socket.

1. Verify proper memory module type.
2. Try another memory socket.
3. Replace memory module if problem 

persists.

219-ECC Memory 
Module Detected 
ECC Modules not 
supported on this 
Platform

Recently added memory 
module(s) support ECC 
memory error correction.

1. If additional memory was recently 
added, remove it to see if the problem 
remains.

2. Check product documentation for 
memory support information.

301-Keyboard Error Keyboard failure. 1. Reconnect keyboard with computer 
turned off.

2. Check connector for bent or missing 
pins.

3. Ensure that none of the keys are 
depressed.

4. Replace keyboard.

303-Keyboard 
Controller Error

I/O board keyboard 
controller.

1. Reconnect keyboard with computer 
turned off.

2. Replace the system board.

Numeric Codes and Text Messages (Continued)
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304-Keyboard or 
System Unit Error

Keyboard failure. 1. Reconnect the keyboard with 
computer turned off.

2. Ensure that none of the keys are 
depressed.

3. Replace the keyboard.
4. Replace the system board.

404-Parallel Port 
Address Conflict 
Detected

Both external and 
internal ports are 
assigned to 
parallel port X.

1. Remove any parallel port expansion 
cards.

2. Clear CMOS. (See Appendix B, 
“Password Security and Resetting 
CMOS.”)

3. Reconfigure card resources and/or 
run Computer Setup.

410-Audio Interrupt 
Conflict

IRQ address conflicts 
with another device.

Enter Computer Setup and reset the IRQ in 
Advanced > Onboard Devices.

411-Network 
Interface Card 
Interrupt Conflict

IRQ address conflicts 
with another device.

Enter Computer Setup and reset the IRQ in 
Advanced > Onboard Devices.

501-Display 
Adapter Failure

Graphics display 
controller.

1. Reseat the graphics card 
(if applicable).

2. Clear CMOS. (See Appendix B, 
“Password Security and Resetting 
CMOS.”)

3. Verify monitor is attached and turned 
on.

4. Replace the graphics card (if 
possible).

510-Splash Screen 
Image Corrupted

Splash Screen image has 
errors.

Install latest version of ROMPaq to restore 
image.

511-CPU, CPUA, or 
CPUB Fan not 
Detected

CPU fan is not connected 
or may have 
malfunctioned.

1. Reseat CPU fan.
2. Reseat fan cable.
3. Replace CPU fan.

Numeric Codes and Text Messages (Continued)
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512-Chassis, Rear 
Chassis, or Front 
Chassis Fan not 
Detected

Chassis, rear chassis, or 
front chassis fan is not 
connected or may have 
malfunctioned.

1. Reseat chassis, rear chassis, or front 
chassis fan.

2. Reseat fan cable.
3. Replace chassis, rear chassis, or front 

chassis fan.

514-CPU or Chassis 
Fan not Detected

CPU or chassis fan is not 
connected or may have 
malfunctioned.

1. Reseat CPU or chassis fan.
2. Reseat fan cable.
3. Replace CPU or chassis fan.

601-Diskette 
Controller Error

Diskette controller 
circuitry or floppy drive 
circuitry incorrect.

1. Run Computer Setup.
2. Check and/or replace cables.
3. Clear CMOS. (See Appendix B, 

“Password Security and Resetting 
CMOS.”)

4. Replace diskette drive.
5. Replace the system board.

605-Diskette Drive 
Type Error

Mismatch in drive type. 1. Run Computer Setup.
2. Disconnect any other diskette 

controller devices (tape drives).
3. Clear CMOS. (See Appendix B, 

“Password Security and Resetting 
CMOS.”)

610-External 
Storage Device 
Failure

External tape drive not 
connected.

Reinstall tape drive or press F1 and allow 
system to reconfigure without the drive.

611-Primary Floppy 
Port Address 
Assignment Conflict

Configuration error. Run Computer Setup and check the 
configuration in Advanced > 
Onboard Devices.

660-Display cache 
is detected 
unreliable

Integrated graphics 
controller display cache 
is not working properly 
and will be disabled.

Replace system board if minimal graphics 
degrading is an issue.

Numeric Codes and Text Messages (Continued)
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912-Computer 
Cover Has Been 
Removed Since Last 
System Startup

Computer cover was 
removed since last system 
startup.

No action required.

914-Hood Lock Coil 
is not Connected

Smart Cover Lock 
mechanism is missing or 
not connected.

1. Reconnect or replace hood locking 
mechanism.

2. Reseat or replace hood locking 
mechanism cable. 

916-Power Button 
Not Connected

Power button harness has 
been detached or 
unseated from 
motherboard.

Reconnect or replace power button 
harness.

917-Front Audio Not 
Connected

Front audio harness has 
been detached or 
unseated from 
motherboard.

Reconnect or replace front audio harness.

918-Front USB Not 
Connected

Front USB harness has 
been detached or 
unseated from 
motherboard.

Reconnect or replace front USB harness.

919-Multi-Bay Riser 
not Connected

Riser card has been 
removed or has not been 
reinstalled properly in the 
system.

Reinsert riser card.

1151-Serial Port A 
Address Conflict 
Detected

Both external and 
internal serial ports are 
assigned to COM1.

1. Remove any serial port expansion 
cards.

2. Clear CMOS. (See Appendix B, 
“Password Security and Resetting 
CMOS.”)

3. Reconfigure card resources and/or 
run Computer Setup or Windows 
utilities.

Numeric Codes and Text Messages (Continued)
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1152-Serial Port B 
Address Conflict 
Detected

Both external and 
internal serial ports are 
assigned to COM2.

1. Remove any serial port expansion 
cards.

2. Clear CMOS. (See Appendix B, 
“Password Security and Resetting 
CMOS.”)

3. Reconfigure card resources and/or 
run Computer Setup or Windows 
utilities.

1155-Serial Port 
Address Conflict 
Detected

Both external and 
internal serial ports are 
assigned to same IRQ.

1. Remove any serial port expansion 
cards.

2. Clear CMOS. (See Appendix B, 
“Password Security and Resetting 
CMOS.”)

3. Reconfigure card resources and/or 
run Computer Setup or Windows 
utilities.

1201-System Audio 
Address Conflict 
Detected

Device IRQ address 
conflicts with another 
device.

Enter Computer Setup and reset the IRQ in 
Advanced > Onboard Devices.

1202-MIDI Port 
Address Conflict 
Detected

Device IRQ address 
conflicts with another 
device.

Enter Computer Setup and reset the IRQ in 
Advanced > Onboard Devices.

1203-Game Port 
Address Conflict 
Detected

Device IRQ address 
conflicts with another 
device.

Enter Computer Setup and reset the IRQ in 
Advanced > Onboard Devices.

Numeric Codes and Text Messages (Continued)
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1720-SMART Hard 
Drive Detects 
Imminent Failure

Hard drive is about 
to fail. (Some hard drives 
have a hard drive 
firmware patch that will 
fix an erroneous error 
message.)

1. Determine if hard drive is giving 
correct error message. Enter 
Computer Setup and run the Drive 
Protection System test under 
Storage > DPS Self-test.

2. Apply hard drive firmware patch 
if applicable. (Available at 
www.hp.com/support.)

3. Back up contents and replace hard 
drive.

1785-Multibay 
incorrectly installed

(for Multibay option/ 
non-USDT systems)
1. Multibay option 

ribbon cables not 
seated or improperly 
attached.

2. Multibay device not 
properly seated.

3. Multibay diskette 
present. 

1. Ensure the Multibay option is 
attached as device 0 on the IDE 
cable.

2. Ensure no other device is attached to 
the same IDE cable.

3. Ensure both ends of the IDE and 
Multibay ribbon cables are properly 
seated.

4. Ensure the Multibay device is fully 
inserted.

5. Ensure a Multibay diskette is not 
present (Multibay diskette drives are 
not supported by the Multibay 
option).

(for integrated Multibay/ 
USDT systems)
1. Multibay device not 

properly seated.
2. Multibay riser not 

properly seated. 

1. Ensure the Multibay device is fully 
inserted.

2. Ensure the Multibay riser is properly 
seated.

Numeric Codes and Text Messages (Continued)
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1794-Inaccessible 
devices attached to 
SATA 1 and/or 
SATA 3
(for systems with 4 
SATA ports)

A device is attached to 
SATA 1 and/or SATA 3. 
Devices attached to these 
connectors will be 
inaccessible while “SATA 
Emulation” is set to 
“Combined IDE 
Controller” in Computer 
Setup.

1. If using Windows 2000 or Windows 
XP, change “SATA Emulation” to 
“Separate IDE Controller” in 
Computer Setup.

2. If not using Windows 2000 or 
Windows XP, relocate the affected 
devices to SATA 0 or SATA 2 (if 
available).

3. Remove the affected devices from 
SATA 1 and SATA 3.

1794-Inaccessible 
device attached to 
SATA 1
(for systems with 2 
SATA ports)

A device is attached to 
SATA 1. Any device 
attached to this 
connector will be 
inaccessible while “SATA 
Emulation” is set to 
“Combined IDE 
Controller” in Computer 
Setup.

1. If using Windows 2000 or Windows 
XP, change “SATA Emulation” to 
“Separate IDE Controller” in 
Computer Setup.

2. If not using Windows 2000 or 
Windows XP, relocate the affected 
device to SATA 0 (if available).

3. Remove the affected device from 
SATA 1.

1796-SATA Cabling 
Error

One or more SATA 
devices are improperly 
attached. For optimal 
performance, the SATA 0 
and SATA 1 connectors 
must be used before 
SATA 2 and SATA 3.

Ensure SATA connectors are used in 
ascending order. For one device, use 
SATA 0. For two devices, use SATA 0 and 
SATA 1. For three devices, use SATA 0, 
SATA1, and SATA 2.

1800-Temperature 
Alert

Internal temperature 
exceeds specification.

1. Check that computer air vents are not 
blocked and the processor cooling 
fan is running.

2. Verify processor speed selection.
3. Replace the processor.
4. Replace the system board.

Numeric Codes and Text Messages (Continued)
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1801-Microcode 
Patch Error

Processor is not 
supported by 
ROM BIOS.

1. Upgrade BIOS to proper version.
2. Change the processor.

1998-Master Boot 
Record has 
been Lost

The previously saved 
copy of the MBR has 
been corrupted.

Run Computer Setup and save the MBR of 
the current bootable disk.

1999-Master Boot 
Record has 
Changed

The current MBR does not 
match the previously 
saved copy of the MBR.

Use extreme caution. The MBR may have 
been updated due to normal disk 
maintenance activities (disk manager, 
fdisk, or format).

Ä Replacing the previously saved MBR 
in such situations can cause data 
loss.

If you are certain the MBR change is 
unintentional and undesired (e.g. due to a 
virus), then run Computer Setup and 
restore the previously saved MBR copy. 
Otherwise, run Computer Setup and either 
disable MBR security or save the MBR of 
the current bootable disk.

2000-Master Boot 
Record Hard Drive 
has Changed

The current bootable 
hard drive is not the 
same as the one that was 
present when MBR 
Security was enabled.

Run Computer Setup and either disable 
MBR security or save the MBR of the 
current bootable disk.

Invalid Electronic 
Serial Number

Electronic serial number 
has become corrupted.

1. Run Computer Setup. If Setup already 
has data in the field or will not allow 
the serial number to be entered, 
download from www.hp.com and run 
SP5572.EXE (SNZERO.EXE).

2. Run Computer Setup and try to enter 
serial number under Security, System 
ID, then save changes.

Numeric Codes and Text Messages (Continued)
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Network Server 
Mode Active and 
No Keyboard 
Attached

Keyboard failure while 
Network Server Mode 
enabled.

1. Reconnect keyboard with computer 
turned off.

2. Check connector for bent or missing 
pins.

3. Ensure that none of the keys are 
depressed.

4. Replace keyboard.

Parity Check 2 Parity RAM failure. Run Computer Setup and Diagnostic 
utilities.

System will not boot 
without fan

CPU fan not installed or 
disconnected in VSFF 
chassis.

1. Open hood, press the Power button, 
and see if the processor fan spins. If 
the processor fan is not spinning, 
make sure the fan's cable is plugged 
onto the system board header. Ensure 
the fan is fully/properly seated or 
installed.

2. If the fan is plugged in and seated 
properly, but is not spinning, then 
replace the processor fan.

Numeric Codes and Text Messages (Continued)
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Troubleshooting Guide www.hp.com A–13



POST Error Messages
POST Diagnostic Front Panel LEDs and 
Audible Codes

This section covers the front panel LED codes as well as the audible 
codes that may occur before or during POST that do not necessarily 
have an error code or text message associated with them.

✎ If you see flashing LEDs on a PS/2 keyboard, look for flashing LEDs 
on the front panel of the computer and refer to the following table to 
determine the front panel LED codes.

✎ Recommended actions in the following table are listed in the order in 
which they should be performed.

Diagnostic Front Panel LEDs and Audible Codes 
Activity Beeps Possible Cause Recommended Action

Green Power LED 
On.

None Computer on. None

Green Power LED 
flashes every two 
seconds.

None Computer in 
Suspend to RAM 
mode (select 
models only) or 
normal Suspend 
mode.

None required. Press any key or move 
the mouse to wake the computer.
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Red Power LED 
flashes two times, 
once every second, 
followed by a two 
second pause.

2 Processor thermal 
protection 
activated:
A fan may be 
blocked or not 
turning.
OR 
The heatsink/fan 
assembly is not 
properly attached 
to the processor. 

1. Ensure that the computer air vents 
are not blocked and the processor 
cooling fan is running.

2. Open hood, press power button, 
and see if the processor fan spins. If 
the processor fan is not spinning, 
make sure the fan's cable is 
plugged onto the system board 
header. Ensure the fan is 
fully/properly seated or installed.

3. If fan is plugged in and seated 
properly, but is not spinning, then 
replace processor fan.

4. Reseat processor heatsink and 
verify that the fan assembly is 
properly attached.

5. Contact an authorized reseller or 
service provider.

Red Power LED 
flashes three times, 
once every second, 
followed by a two 
second pause.

3 Processor not 
installed (not an 
indicator of bad 
processor).

1. Check to see that the processor is 
present.

2. Reseat the processor.

Diagnostic Front Panel LEDs and Audible Codes (Continued)

Activity Beeps Possible Cause Recommended Action
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Red Power LED 
flashes four times, 
once every second, 
followed by a two 
second pause.

4 Power failure 
(power supply is 
overloaded).

1. Open the hood and ensure the 
4-wire power supply cable is 
seated into the connector on the 
system board.

2. Check if a device is causing the 
problem by removing ALL attached 
devices (such as hard, diskette, or 
optical drives, and expansion 
cards). Power on the system. If the 
system enters the POST, then power 
off and replace one device at a 
time and repeat this procedure until 
failure occurs. Replace the device 
that is causing the failure. Continue 
adding devices one at a time to 
ensure all devices are functioning 
properly.

3. Replace the power supply.
4. Replace the system board.

Red Power LED 
flashes five times, 
once every second, 
followed by a two 
second pause.

5 Pre-video memory 
error.

1. Reseat DIMMs. Power on the 
system.

2. Replace DIMMs one at a time to 
isolate the faulty module.

3. Replace third-party memory with 
HP memory.

4. Replace the system board.

Red Power LED 
flashes six times, 
once every second, 
followed by a two 
second pause.

6 Pre-video graphics 
error. 

For systems with a graphics card:
1. Reseat the graphics card. Power on 

the system.
2. Replace the graphics card.
3. Replace the system board.

For systems with integrated graphics, 
replace the system board.

Diagnostic Front Panel LEDs and Audible Codes (Continued)

Activity Beeps Possible Cause Recommended Action
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Red Power LED 
flashes seven times, 
once every second, 
followed by a two 
second pause.

7 System board 
failure (ROM 
detected failure 
prior to video).

Replace the system board.

Red Power LED 
flashes eight times, 
once every second, 
followed by a two 
second pause.

8 Invalid ROM 
based on bad 
checksum.

1. Reflash the ROM using a ROMPaq 
diskette. See the “ROM Flash” 
section of the Desktop 
Management Guide on the 
Documentation CD.

2. Replace the system board.

Red Power LED 
flashes nine times, 
once every second, 
followed by a two 
second pause.

9 System powers on 
but is unable to 
boot.

1.  Check that the voltage selector, 
located on the rear of the power 
supply (some models), is set to the 
appropriate voltage. Proper voltage 
setting depends on your region.

2. Replace the system board.
3. Replace the processor. 

Red Power LED 
flashes ten times, 
once every second, 
followed by a two 
second pause.

10 Bad option card. 1. Check each graphics card by 
removing the card (one at a time if 
multiple cards), then power on the 
system to see if fault goes away.

2. Once a bad card is identified, 
remove and replace the bad option 
card.

3. Replace the system board.

Diagnostic Front Panel LEDs and Audible Codes (Continued)

Activity Beeps Possible Cause Recommended Action
Troubleshooting Guide www.hp.com A–17



POST Error Messages
System does not 
power on and LEDs 
are not flashing.

None System unable to 
power on.

Press and hold the power button for less 
than 4 seconds. If the hard drive LED 
turns green, then:
1. Check that the voltage selector, 

located on the rear of the power 
supply, is set to the appropriate 
voltage. Proper voltage setting 
depends on your region.

2. Remove the expansion cards one at 
a time until the 3V_aux light on the 
system board turns on.

3. Replace the system board.
OR
Press and hold the power button for less 
than 4 seconds. If the hard drive LED 
does not turn on green then:
1. Check that the unit is plugged into 

a working AC outlet.
2. Open hood and check that the 

power button harness is properly 
connected to the system board.

3. Check that both power supply 
cables are properly connected to 
the system board.

4. Check to see if the 3V_aux light on 
the system board is turned on. If it 
is turned on, then replace the 
power button harness.

5. If the 3V_aux light on the system 
board is not turned on, then 
replace the power supply.

6. Replace the system board.

Diagnostic Front Panel LEDs and Audible Codes (Continued)

Activity Beeps Possible Cause Recommended Action
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Password Security and Resetting CMOS

This computer supports security password features, which can be 
established through the Computer Setup Utilities menu.

This computer supports two security password features that are 
established through the Computer Setup Utilities menu: setup 
password and power-on password. When you establish only a setup 
password, any user can access all the information on the computer 
except Computer Setup. When you establish only a power-on 
password, the power-on password is required to access Computer 
Setup and any other information on the computer. When you establish 
both passwords, only the setup password will give you access to 
Computer Setup.

When both passwords are set, the setup password can also be used 
in place of the power-on password as an override to log in to the 
computer. This is a useful feature for a network administrator.

If you forget the password for the computer, there are two methods 
for clearing that password so you can gain access to the information 
on the computer:

■ Resetting the password jumper

■ Using the Clear CMOS button

Ä
CAUTION: Pushing the CMOS button will reset CMOS values to factory 
defaults and will erase any customized information including passwords, 
asset numbers, and special settings. It is important to back up the 
computer CMOS settings before resetting them in case they are needed 
later. Back up is easily done through Computer Setup. See the Computer 
Setup (F10) Utility Guide on the Documentation CD for information on 
backing up the CMOS settings.
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Resetting the Password Jumper
To disable the power-on or setup password features, or to clear the 
power-on or setup passwords, complete the following steps:

1. Shut down the operating system properly, then turn off the 
computer and any external devices, and disconnect the power 
cord from the power outlet.

2. With the power cord disconnected, press the power button again 
to drain the system of any residual power.

Å
WARNING: To reduce the risk of personal injury from electrical shock 
and/or hot surfaces, be sure to disconnect the power cord from the wall 
outlet, and allow the internal system components to cool before touching.

Ä
CAUTION: When the computer is plugged in, the power supply always 
has voltage applied to the system board even when the unit is turned off. 
Failure to disconnect the power cord can result in damage to the system.

Ä
CAUTION: Static electricity can damage the electronic components 
of the computer or optional equipment. Before beginning these 
procedures, ensure that you are discharged of static electricity by briefly 
touching a grounded metal object. See the Safety & Regulatory 
Information guide on the Documentation CD for more information.

3. Remove the computer cover or access panel.

4. Locate the header and jumper.

✎ The password jumper is green so that it can be easily identified. For 
assistance locating the password jumper and other system board 
components, see the Illustrated Parts Map (IPM) for that particular 
system. The IPM can be downloaded from www.hp.com/support.

5. Remove the jumper from pins 1 and 2. Place the jumper on either 
pin 1 or 2, but not both, so that it does not get lost. 

6. Replace the computer cover or access panel.

7. Reconnect the external equipment.
B–2 www.hp.com Troubleshooting Guide

http://www.hp.com/support


Password Security and Resetting CMOS
8. Plug in the computer and turn on power. Allow the operating 
system to start. This clears the current passwords and disables the 
password features.

9. To establish new passwords, repeat steps 1 through 4, replace the 
password jumper on pins 1 and 2, then repeat steps 6 through 8. 
Establish the new passwords in Computer Setup. Refer to the 
Computer Setup (F10) Utility Guide on the Documentation CD 
for Computer Setup instructions.

Clearing and Resetting the CMOS
The computer’s configuration memory (CMOS) stores password 
information and information about the computer’s configuration.

Using the CMOS Button
1. Turn off the computer and any external devices, and disconnect 

the power cord from the power outlet.

2. Disconnect the keyboard, monitor, and any other external 
equipment connected to the computer.

Å
WARNING: To reduce the risk of personal injury from electrical shock 
and/or hot surfaces, be sure to disconnect the power cord from the wall 
outlet, and allow the internal system components to cool before touching.

Ä
CAUTION: When the computer is plugged in, the power supply always 
has voltage applied to the system board even when the unit is turned off. 
Failure to disconnect the power cord can result in damage to the system.

Ä
CAUTION: Static electricity can damage the electronic components 
of the computer or optional equipment. Before beginning these 
procedures, ensure that you are discharged of static electricity by briefly 
touching a grounded metal object. See the Safety & Regulatory 
Information guide on the Documentation CD for more information.
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3. Remove the computer cover or access panel.

Ä
CAUTION: Pushing the CMOS button will reset CMOS values to factory 
defaults and will erase any customized information including passwords, 
asset numbers, and special settings. It is important to back up the 
computer CMOS settings before resetting them in case they are needed 
later. Back up is easily done through Computer Setup. See the Computer 
Setup (F10) Utility Guide on the Documentation CD for information on 
backing up the CMOS settings.

4. Locate, press, and hold the CMOS button in for five seconds.

✎ Make sure you have disconnected the AC power cord from the wall 
outlet. The CMOS button will not clear CMOS if the power cord is 
connected.

CMOS button

✎ For assistance locating the CMOS button and other system board 
components, see the Illustrated Parts Map (IPM) for that particular 
system.

5. Replace the computer cover or access panel.
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6. Reconnect the external devices.

7. Plug in the computer and turn on power.

✎ You will receive POST error messages after clearing CMOS and 
rebooting advising you that configuration changes have occurred. Use 
Computer Setup to reset your passwords and any special system 
setups along with the date and time.

See the Desktop Management Guide on the Documentation CD for 
further instructions on reestablishing passwords. For instructions on 
Computer Setup, see the Computer Setup (F10) Utility Guide on the 
Documentation CD.

Using Computer Setup to Reset CMOS
To reset CMOS through Computer Setup, you must first access the 
Computer Setup Utilities menu.

When the Computer Setup message appears in the lower-right corner 
of the screen, press the F10 key. Press Enter to bypass the title 
screen, if necessary.

✎ If you do not press the F10 key while the message is displayed, you 
must turn the computer off, then on again, to access the utility.

A choice of five headings appears in the Computer Setup Utilities 
menu: File, Storage, Security, Power, and Advanced.

To reset CMOS to the factory default settings first set time and date, 
then use the arrow keys or the Tab key to select File > Set Defaults 
and Exit. This resets the soft settings that include boot sequence 
order and other factory settings. It will not, however, force hardware 
rediscovery.

See the Desktop Management Guide on the Documentation CD for 
further instructions on reestablishing passwords. For instructions on 
Computer Setup, see the Computer Setup (F10) Utility Guide on the 
Documentation CD.
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Drive Protection System (DPS)

The Drive Protection System (DPS) is a diagnostic tool built into the 
hard drives installed in select computers. DPS is designed to help 
diagnose problems that might result in unwarranted hard drive 
replacement.

When these systems are built, each installed hard drive is tested using 
DPS, and a permanent record of key information is written onto the 
drive. Each time DPS is run, test results are written to the hard drive. 
Your service provider can use this information to help diagnose 
conditions that caused you to run the DPS software.

Running DPS will not affect any programs or data stored on the hard 
drive. The test resides in the hard drive firmware and can be executed 
even if the computer will not boot to an operating system. The time 
required to execute the test depends on the manufacturer and size 
of the hard drive; in most cases, the test will take approximately 
two minutes per gigabyte.

Use DPS when you suspect a hard drive problem. If the computer 
reports a SMART Hard Drive Detect Imminent Failure message, there 
is no need to run DPS; instead, back up the information on the hard 
drive and contact a service provider for a replacement hard drive.
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Accessing DPS Through Diagnostics for Windows
To access DPS through Diagnostics for Windows, perform the 
following steps:

1. Turn on the computer and select Start > Control Panel > 
Diagnostics for Windows.

A choice of five possible headings appears in the Diagnostics 
screen: Overview, Test, Status, Log, and Error.

2. Select Test > Type of Test.

A choice of three tests appear: Quick Test, Complete Test, and 
Custom Test.

3. Select Custom Test.

A choice of two test modes is offered: Interactive Mode and 
Unattended Mode.

4. Select Interactive Test > Storage > Hard Drives.

5. Select the specific drives to be tested > Drive Protection System 
Test > Begin Testing.

When the test has been completed, one of three messages will be 
displayed for each of the drives tested:

■ Test Succeeded. Completion Code 0.

■ Test Aborted. Completion Code 1 or 2.

■ Test Failed. Drive Replacement Recommended. Completion 
Code 3 through 14.

If the test failed, the completion code should be recorded and reported 
to your service provider for help in diagnosing the computer problem.
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Accessing DPS Through Computer Setup
When the computer does not power on properly you should use 
Computer Setup to access the DPS program. To access DPS, perform 
the following steps:

1. Turn on or restart the computer.

2. When the F10 Setup message appears in the lower-right corner of 
the screen, press the F10 key.

✎ If you do not press the F10 key while the message is displayed, you 
must turn the computer off, then on again, to access the utility.

A choice of five headings appears in the Computer Setup Utilities 
menu: File, Storage, Security, Power, and Advanced.

3. Select Storage > DPS Self-Test.

The screen will display the list of DPS-capable hard drives that 
are installed on the computer.

✎ If no DPS-capable hard drives are installed, the DPS Self-Test option 
will not appear on the screen.

4. Select the hard drive to be tested and follow the screen prompts to 
complete the testing process.

When the test has been completed, one of three messages will be 
displayed:

■ Test Succeeded. Completion Code 0.

■ Test Aborted. Completion Code 1 or 2.

■ Test Failed. Drive Replacement Recommended. Completion 
Code 3 through 14.

If the test failed, the completion code should be recorded and reported 
to your service provider for help in diagnosing the computer problem.
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Setting up Analog/Digital Audio Output

Some computers may have an integrated audio solution that supports 
analog or digital external stereo speakers. These systems are capable 
of auto-sensing the speaker type and outputting the correct signal. To 
manually change between analog, digital, and auto-sense, complete 
the following set of procedures based on the operating system.

✎ If you set digital as the Output Mode, the internal speaker and 
external analog speakers will no longer output audio until you switch 
back to an auto-sense or analog mode. If you set analog as the Output 
Mode, external digital speakers will not function until you change the 
output mode back to an auto-sense or digital mode.

In Microsoft Windows XP:

1. Click Start > Control Panel and then double-click the Sounds, 
Speech, and Audio Devices icon.

2. Select the Hardware tab.

3. Highlight the appropriate audio device.

4. Click Properties to open up the Device Properties panel.

5. Click the Properties tab.

6. Click the “+” next to Audio Devices to expand it.

7. Highlight the appropriate driver by clicking it.

8. Click Properties.

9. Click Settings.

10. Change the Output Mode to the desired setting.

11. Click OK to close the Properties panel.

12. Close the Control Panel.
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